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本マニュアル中での装置の表示について、一部下記のように表示しております。 
機種 略称 

API 2000TM LC/MS/MS 
System 

- API 2000TM 

- QTRAP® LC/MS/MS 
System 

QTRAP® 

API 3000TM LC/MS/MS 
System 

- API 3000TM 

API 3200TM LC/MS/MS 
System 

3200 QTRAP® LC/MS/MS 
System 

API 3200 TM 
3200 QTRAP® 

API 4000TM LC/MS/MS 
System 

4000 QTRAP® LC/MS/MS 
System 

API 4000TM 
4000 QTRAP® 

AB SCIEX Triple Quad™ 
4500 LC/MS/MS System 

AB SCIEX QTRAP® 4500 
LC/MS/MS System 

Triple QuadTM 4500 
QTRAP® 4500  

API 5000TM LC/MS/MS 
System 

- API 5000TM 

AB SCIEX Triple Quad™  
5500 LC/MS/MS System 

AB SCIEX QTRAP® 5500 
LC/MS/MS System 

Triple QuadTM 5500 
QTRAP® 5500  

AB SCIEX Triple Quad™  
6500 LC/MS/MS System 

AB SCIEX QTRAP® 6500 
LC/MS/MS System 

Triple QuadTM 6500 
QTRAP® 6500 
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9. 略語一覧 

ESI : Electrospray Ionization 

（大気圧下で行われるイオン化の一つで、エレクトロスプレー技術を使った 
イオン化法) 

APCI : Atmospheric Pressure Chemical Ionization  
（大気圧下で行われるイオン化の一つで、通常は大気圧スプレーによって生成 
した気体試料を、コロナ放電で生成させたイオン種（反応イオン）と反応させて

イオン化すること) 

LC :  Liquid Chromatography （液体クロマトグラフィ） 

IC :  Ion Chromatography （イオンクロマトグラフィ） 

FIA : Flow Injection Analysis  
（注入したサンプルを LC カラムを使わずに分析する方法） 

m/z : Mass-to-charge ratio 
（質量電荷比。 イオンの質量(m)を電荷数(z)で割った値） 

MRM :  Multiple Reaction Monitoring 
（Q1 で選択された特定の前駆イオン (Precursor ion) から生じる特定の 
イオン の質量を連続的に検出する方法） 

Q1MS : Q1 MS Scan 
（マススペクトルを測定するために、Q1 で走査したイオンを検出する方法） 

Q3MS : Q3 MS Scan 
（マススペクトルを測定するために、Q3 で走査したイオンを検出する方法） 

EMS :  Enhanced MS Scan 
（Liner Ion Trap を利用して、走査したイオンを検出する方法） 

MS2 : Product Ion Scan 
（特定の前駆イオン (Precursor ion) から生じるイオン (Product ion) を 
検出する方法） 

EPI : Enhanced Product Ion Scan  
（Liner Ion Trap を利用して Product Ion を検出する方法） 

Prec : Precursor Ion Scan 
（特定のプロダクトイオンを生じる総ての前駆イオンを検出する方法） 

NL : Neutral Loss Scan 
（特定の中性化学種を脱離する総ての前駆イオンを検出する方法） 

IDA : Information Dependent Acquisition  
（サーベイスキャンで取得した MS スペクトルから強度の強いイオンを選択し、 
リアルタイムで MS2 あるいは EPI のデータを取得する方法) 

DP : Declustering Potential  
（イオンを MS 内部へ引き込むための電圧であり、オリフィスプレートに電圧が 

かかる） 
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CE : Collision Energy  
（MS/MS などの CAD 実験において、Q2 でイオンを加速させるための電圧で 
あり、Q0 と Q2 の電位差で表示される） 

LLOQ : Low Limited of Quantification （定量下限値） 

LOD : Low Limited of Detection （検出下限値） 

％CV : Coefficient of Variance (in percent) 

RT :  Retention Time （保持時間） 

S/N : Signal to Noise  

IS : Internal Standard （内部標準物質） 
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2 ソフトウェアの概要 

Analyst®ソフトウェアのファイル構造 

 ワークステーションの C ドライブに OS、x ドライブ（x：
納入先仕様により D、E、F 等異なります）に Analyst®

ソフトウェアにて取得したデータ等が 保存されていま

す。 

 また全てのデータ、分析メソッド等は項目（日付、分析

者、成分名等）ごとに分類することができ、これを Project と呼びます。 

 データ等は該当 Project 内の Data フォルダ内に保存されます。 
 （x ://Analyst Data/Project/Data） 

 Analyst®ソフトウェアによって作成されるファイル

の種類は様々ありますが、ファイルの種類により特定

の拡張子が自動的に付けられます。高い頻度で用いら

れるのは、.dam（分析メソッド）、.dab（バッチ）、.wiff
（データ）、.qmf（解析メソッド）及び.rdb（定量結

果）です。 

Project 

 Analyst®ソフトウェアでは、データや測定法、定量結果などを、Project ごとに管理し

ています。Project は、Analyst®ソフトウェア上部中央に表示され、プルダウンメニュー

により選択できます。 

 データや測定法、定量結果などは、そのファイルが保存されている Project を選択して

いる時にのみ開くことができます。ただし、すでに開いているデータなどは、Project
を変更しても表示されたままです。 

 新たに測定を開始する時や、測定者が変わる時などは違う Project を作成し、使用しま

す。 

 例えば、ある測定者が Project を作成し、その Project の中に自分のファイルを保存し

ていると、該当する Project を選択するだけで自分のファイルだけを見ることができる

ようになります。（x://Analyst Data/project） 
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API Instrument という Project 

 API Instrument という Project は特別な Project です。この Project の中にはキャリブ

レーションデータ(質量分析器のマスナンバーを決めている表)やパラメータの初期値な

ど非常に重要なファイルが入っています。この Project に保存されているファイルやメ

ソッド等を変更もしくは削除した場合、機器が正常に動作しなくなる恐れがあります。 

API Instrument（Project）は、キャリブレーションを行う時にのみ使用してください。 
 

Project は、ドライブ x://Analyst Data/Projects の中に入っ

ています。それぞれの Project のフォルダには、測定法や測

定データ、定量結果などが格納されます。 

 Acquisition Method： 

PPG での Calibration を行う際に使用するメソッドが格納

されています。 

 Configuration： 

Analyst®ソフトウェアの Configuration モードで設定した、

制御する装置の組み合わせ（MS 単体 or LC+MS で使用す

るか）のファイルが格納されています。 

 Instrument Data： 

キャリブレーションファイルが格納されています。 

 Parameter Settings： 

MS 内部の電圧、およびイオンソースのデフォルトの設定値

のファイルが格納されています。 

 Preferences： 

Tuning に用いる PPG のマスナンバーのリスト等を含む

ファイルが格納されています。 

 Templates： 

印刷時のヘッダ、フッターなどを設定する Report Template 等のファイルが格納されてい

ます。 

 Tuning Cache： 

Manual Tuning で測定したデータが一時的に保存されるフォルダです。フォルダ内にデー

タが増えてきた場合、削除します。 
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バックアップについて 

 バックアップを取る際は、Analyst®ソフトウェアがインストールされているドライブ

x://Analyst Data のフォルダごとバックアップすることをお勧め致します。 

 Analyst Data のフォルダには、Projects のフォルダだけでなく、ライブラリーや化合

物データベースのファイルが入っています。 
o Projects のフォルダ  
o 化合物データベースのファイル  
o ライブラリーのファイル  

 最低限 API Instrument の Project は、別のドライブあるいは CD-R などのメディアに

バックアップすることをお願い致します。 

 API Instrumentのフォルダには、下記の 3つの重要なファイル等が保存されています。 
o Instrument Data 
o Parameter Setting 
o Preference 

 

Analyst®ソフトウェアの 5 種類のモード 

Analyst®ソフトウェアは、機器の設定、最適化、測定、解析およ

び定量の機能を持っています。それぞれの機能は、以下の 5 種類

のモードに対応しています。画面の左が Navigation Bar です。 

 Configure モード： 

制御する装置の選択（MS 単体で使用するか、LC/MS として使用

するか）などを決定します。 

 Tune and Calibrate モード： 

測定条件の最適化や質量分析器の質量補正などを行います。 
 

 Acquire モード： 

測定用のメソッドを作成し、データを取り込みます。 

 Explore モード： 

データの閲覧や、解析に使用します。スペクトルの差し引きなど

も行うことがます。 

 Quantitate モード： 

定量を行います。検量線の作成、平均値や標準偏差などを求める

ことができます。 
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 上記フローチャートは、測定成分に対する自動最適化を行い、そこで得られた分析メ

ソッドを用いてクロマト測定を行い、最終的に定量計算を行うまでの手順を示していま

す。 

 これらのモードは、ほぼ独立して機能し、異なるソフトウエアのように機能します。 

 実際、モードを切り替えると上部ツールバーの表示内容が変わり、違う機能を持ってい

ることがわかります。この機能により、データを取り込みながら他のデータを解析した

り、定量したりすることができます。 

 この時、それぞれの選択したモードで表示されているデータは、そのモードが選択され

ている時のみ表示され、他のモードを選択すると画面上からは消えます。この場合でも、

裏の画面で表示されているような状態になっており、もとのモードに戻すと現れます。 

 そのモードで表示されているファイルの数は、たとえば Acquire(3)というようにカッコ

の中の数字として表示されます。 

 

  

Acquire mode [P36～45]

データの採取

Explore mode　[P46～48]

データの閲覧

Quantitate mode　[P49～67]

 定量計算の実施

Configure mode [P12]

LC+MSで使用

Tune mode [P25～35]

Configure mode [P12]

MS単体で使用

Tune mode [P16～24]

Infusionによる自動最適化 FIAによる自動最適化
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3 測定 

3.1 測定の流れ 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

MS 内部パラメータの自動最適化 

(Compound Optimization) 

無し 

しない 

イオンソースの 
最適化 

 最適化済みの Acquisition Method がある 

 

有り 

イオンソースパラメーターの最適化 

(Compound Optimization) 

する 

Acquisition Method を作成する 
(Build Acquisition Method) 

システムの平衡化を行う(Queue 

Manager 画面で Equilibrate) 

Acquisition Batch を作成する 

（Build Acquisition Batch） 

測定を実行する 

(Queue Manager 画面の Start) 

データの確認を行う 

（Open Data File） 

定量計算を行う 

（MultiQuant） 

Analyst®ソフトウェアの起動、Project の選択、制御する機器の設定

（Hardware Configuration） 



3-2 

 

3.2 ソフトウェアの起動と機器の設定 

Analyst t®ソフトウェアの起動 

デスクトップ上の Analyst®ソフトウェアのアイコン をダブルクリックします。 

または、Start メニュー>Program>AB SCIEX>Analyst>Analyst1.x.x から、 

Analyst®ソフトウェアを起動します。 

Project の変更、作成 
以降の方法で該当する Project を選択、または新規 Project を作成します。 

Project の選択 

 以前使用した Project を使用する場合は、プルダウンから目的の Project を選択して

ください。 

 

 

 

 

 

 

 

Project の作成 

 メニューから Tools>Project>Create 
Project を選択します。 

 開いた画面で、Project name 欄に該

当する Project 名を入力します。 

 OK をクリックすることで Project が

作成されます。 

 

 

 

①  
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制御する機器を設定する 

Analyst®ソフトウェアで制御する機器を設定します。 

 Hardware Configuration をダブルクリックします。 

 使用する機器が組み込まれている Profile (Analyst®ソフトウェアでは、制御する 

機器の設定ファイルを Profile と言います) を選択し、Activate Profile をクリック

します。 

※ Training では、MassSpecOnly を Activate してください。 

※ 選択されている Profile に緑色のチェックマークが点灯し、Analyst®    

ソフトウェアが機器を認識している状態になります。 

※ LC を接続して測定をする場合は Mass+LC のように、Mass と LC を組み合

わせてある Profile を Activate します。 

※ Activate 時に点灯するマークで機器を認識している状態がわかります。 

 ：Profile が正常に認識されています。 

 ：Profile に制御エラーが発生しています。 

 Hardware Configuration の Close をクリックし、ウィンドウを閉じます。 

※ Analyst®ソフトウェアで制御している機器が画面右下の Status bar にアイコ

ンとして表示されます。 

※ アイコンの色で装置の状態が確認できます。 

黄色：Standby  

緑：Ready  

赤：Error 

※ 各アイコンをダブルクリックする

ことで該当モジュール名の確認及

び、現在の状態を確認することが出

来ます。 

※ 右図は MS の状態を表示させたも

ので、MS の真空度や現在使用して

いるイオンソースの種類を確認す

ることが出来ます 

  

真空度 

イオンソースの種類 
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機器を Ready 状態 (右下のアイコンが緑色の状態) にする 

 Navigation Bar の Acquire を選択し、Acquire モードにします。 

 メニューの View>Sample Queue を選択し、Queue Manager を開きます。 

※ ツールバーの    (View Queue アイコン)をクリックしても開きます。 

 Queue Manager が開いている状態で、メニューの Acquire>Ready を選択します。 

※ ツールバーの  (Ready アイコン)をクリックしても開きます。 

※ Analyst®ソフトウェア画面右下の機器アイコンが緑

色となり、Ready (制御可能状態) になります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 測定を終えた場合、同じく Queue Manager 画面が開いている状態で、メニューの

Standby を選択します。 

※ Queue Manager 画面が開いていないと、機器の Standby、Ready の変更がで

きません。 

 

 右下のアイコンが黄色になり、ガスやターボガスの加熱、LC のポンプ等が止まり

ます。 

※ イオンソースの熱を上げるなど機器の平衡化が必要な場合は、メニューの

Acquire>Equilibrate を選択し、開いた画面で平衡化に使用するメソッドを選

択し、平衡化を行います。 

 

  

Queue Manager 
Ready 

Standby 
Equilibrate 

Acquire  

View Queue  
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3.3 最適化 

ここでは基本となる測定用の MS メソッドを作成します。 

測定用 MS メソッドを作成するには、A)MS 内部パラメータと B)イオンソース  

パラメータの 2 種類の最適化を行います。まず MS 内部パラメータの最適化を行

い、その後イオンソースパラメーターの最適化を行います。 

A) MS 内部のパラメータの最適化 

￭ DP、EP、CE、CXP などの MS 内部パラメータを最適な値に設定します。 

￭ シリンジポンプを使って、一定の低流速で対象標準物質の溶液を持続注入し

ながら最適化を行います。※この操作を Infusion(IF)の最適化と呼びます。 
 
 
 
 
 
 
 

B) イオンソースのパラメータの最適化 

￭ CUR、CAD、IS、TEMP、GS1、GS2 などを最適な値に設定します。 

￭ カラムを付けない状態で LC/MS として複数回注入動作を繰り返しながら最

適化を行います。 

￭ この操作を FIA（Flow Injection Analysis）の最適化と呼びます。 

 
 

 

 

 

￭ Training では Reserpine 標準物質を用いて最適化～定量までを説明していき 
ますが、他の成分でも同様の手順にて測定を行うことが出来ます。 
 
 
 

  

【ヒント】 
✓この最適化は成分ごとに行う必要があります。 
✓可能な限り単成分の標準液を使用します。 
✓イオン源の種類（ESI または APCI）が変わっても、最適化し直す必要は 

ありません。※APCIでの最適化は別冊のAPCI操作ガイドをご参照ください。 

【ヒント】 
✓20 成分まで同時に測定できます。 
✓イオン源の種類や LC 条件（流速や溶媒比率）が大きく変更された際には、 
最適化し直します。 
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Calculator を用いたモノアイソトピック質量(精密質量)と平均分子量の計算方法 

※ 目的の化合物のモノアイソトピック質量を計算する方法です。 

 Tools メニューから Calculators を選択します。 

 Mass Property のタブをクリックし、Formula に計算する組成式（アダクトを加味

したもの）を入力します。 

 Calculate をクリックすることで、Exact Mass にモノアイソトピック質量が表示さ

れます。(平均分子量は Average Mass に表示されます。) 

 

 

 

 

 

 

 

 

 

 

 

 

MS 内部のパラメータの最適化（インフュージョンの最適化） 

【Infusion 最適化の準備】 

 標準物質の溶液を調製します。 
 
※Infusion の最適化時に使用する標準液の目安となる濃度 

機種 濃度 

API 2000TM 、QTRAP® 1000ng/mL 

API 3000TM 、API 3200TM、3200 QTRAP®、API 4000TM 
4000 QTRAP®、Triple Quad™4500、QTRAP® 4500 

100ng/mL 

API 5000TM、Triple Quad™ 5500、QTRAP® 5500、 
Triple Quad™ 6500、QTRAP® 6500 

10ng/mL 

 標準溶液を、1mL のシリンジに詰めます 
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 シリンジポンプにセットします。 

 ターボイオンスプレーが装着されていることを確認します。 

 イオンソースのタイプは Analyst®ソフトウェア上の右下マスのアイコンをダブル

クリックすると表示されます（P.3-1 参照）。 

 シリンジから繋がるピークチューブをイオンソースへ接続します。 

 以下を参考にスプレー位置を調整します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

スプレー位置の調整-1：API 2000TM LC/MS/MS System の場合 

・Infusion 測定時 
スプレー先端の延長線がオリフィス穴より 
2mm 程度下になるように調整します。 

・LCMS 測定時 
※スプレーの位置を Infusion 時よりも 5mm 程度 

離します。 

※スプレーが直接穴に吹き付けられると、感度が 
低下し、質量分析器を汚す可能性があります。 

スプレー位置の調整-2：API 3000TM LC/MS/MS System の場合 

・Infusion 測定時 
スプレー先端の延長線がオリフィス穴より 2mm 

程度下になるように調整します。 

・LCMS 測定時 

※スプレーの位置を Infusion 時よりも 5mm 程度 

離します。 

※スプレーが直接穴に吹き付けられると、感度が 

 低下し、質量分析器を汚す可能性があります。 

※外付けのターボガスのコントローラは、 

6000mL/min 程度の流量に調節します。 
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スプレー位置の調整-3：その他機種の場合 
・Infusion 測定時 

（流速：5～20uL/min 程度） 

縦（X）位置：5 

横（Y）位置：5 

※オリフィスに一番近い位置 

になります。 

・LCMS 測定時 

（流速：200～500uL/min 程度） 

縦（X）位置：3 or 2 

横（Y）位置：7 

※オリフィスから少し離すことで 

感度が向上すると共に、 

汚れにくくなります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

縦（X）位置 

横（Y）位置 
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 Tune and Calibrate モードの Manual Tuning をダブルクリックします。 

 左側は初期値のままとし、右側の Scan type が Q1MS になっていることを確認して

ください。 

 Positive モードあるいは Negative モードを選択します。 

※ Reserpine の場合は、Positive を選択します。 

 Scan type の右側の Start および Stop にスキャンする幅を入力します。Reserpine
（分子量 608）の場合、Start-Stop には 590 から 660 までを入力します。 

       【ヒント】 

※ 分子量の 10Da 程度小さい値から、50Da 程度大きい値 (アダクトイオンを確

認するため) を入力します。 

※ 複数の化合物を同時に最適化する場合、すべての化合物が見られる範囲とし

ます。 

 Scan rate を 1000Da/s に設定します。 

    【注意】 

※ Software の version により Scan rate が設定できない場合があります。この

場合、Time に Scan 1 サイクルあたりの時間（秒）を入力してください。時

間の目安は Scan 間隔が 300～400 で 1 秒程度（Training の Reserpine では

0.2 程度になります。 

 画面中央下部の Durations に測定時間を入力します。 

※ 通常持続注入が安定しているかどうかを確認するためには 5から 10分程度を

入力します。 

 左上の Start をクリックし、測定を開始します。 

※ 測定データは保存されません。 

 以降を参考に流速は、5～10μL/min 程度でシリンジポンプをスタートします。 

 【ヒント】 

※ 最初はチューブの中にエアが入っているので、スペクトルがとびとびになる

ことがありますが、しばらく経つと安定します。急ぐ場合は、シリンジを少

し手で押すか、流速を最初のうちだけ上げることで、安定するまでの時間を

短くすることが出来ます。 

③ 
⑤ 

② 
⑥ 

⑦

④ 

② 
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シリンジポンプのスタート方法-1 

※ API 3000TM、API 4000TM、4000 QTRAP®及び API 5000TM につきましては 

シリンジポンプのスタート方法-2 を参照ください。 

 Syringe Pump Method を選択し、Syringe Diameter にシリンジの内径を、Flow 
rate に流速を入力します。 

※ 納品時付属の 1 mL ガスタイトシリンジ(ハミルトン社製)の内径は 4.61 mm 
になります。 

 Start Syringe Pump ボタンをクリックします。(ボタンは Stop Syringe Pump に変

わります。) 
※ 測定途中で流速をかえたいときは、Flow rate に流速を入力後 Set Flow rate 

ボタンをクリックします。 

※ シリンジポンプを止めたいときは、Stop Syringe Pump ボタンをクリックし

ます。 

 

 

 

 

 

 

 

 

 

 

 

  

API 2000TM    TripleQuad 4500TM、QTRAP ® 4500 

QTRAP ®     TripleQuad 5500TM、QTRAP® 5500 

API 3200TM、QTRAP ® 3200  TripleQuad 6500TM、QTRAP ® 6500 
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シリンジポンプのスタート方法-2 

API 3000TM、API 4000TM、4000 QTRAP®及び API 5000TM  

シリンジポンプが内蔵されていませんので、Manual Tune 画面からは制御できません。シ

リンジポンプ本体のボタンで操作を行います。 

 外付けのシリンジポンプの電源を入れます。 

 SET ボタンを押した後、流速を入力し、Enter ボタンを押します。 

 続けて diam ボタンを押してシリンジ内径を入力し、Enter ボタンを押します。 

 Run/Stop ボタンを押して、シリンジポンプをスタートさせます。 

 シリンジポンプを止めたいときは、Run/Stop ボタンを再度押します。 

 納品時付属の 1 mL ガスタイトシリンジ(ハミルトン社製)の Syringe Diameter（内

径）は 4.61 mm です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Run/Stop ボタン 

Enter ボタン diam ボタン 
Set ボタン 
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 以下の 4 項目を確認します。自動最適化を実行するためには、以下の条件が満たさ

れている必要があります。 

a. 左下のクロマトグラム画面の TIC が安定していること 

b. Positive、Negative Mode のどちらでイオン化するか確認すること 

※ トレーニングで使用する Reserpine の場合、Positive モードの方が     

よりイオン強度が高くなります。(m/z 609) 

c. 目的化合物由来のイオンが観測されていること 

d. 目的化合物由来のイオンのイオン強度が 105～106cps の間であること 

※ Positive、Negative Mode 共に、対象化合物の感度が 105～106cps の間に入ら

ない場合は、標準溶液の濃度を調整してください。 

 

 確認後、Stop をクリックします。 

 Manual tuning 画面を閉じます。 

※ 画面を閉じる時に保存するかどうかの警告がでますので、No で閉じます。 

     【重要】 

※ シリンジポンプは止めずに動いたままにしてください。 
 

 

  

a 

b, c 
d 
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Infusioin を用いた MS 内部パラメータの最適化 

Compound Optimization で MS 内部（真空部内) のパラメータの最適化を行います。

（MRM 測定メソッドの作成） 

※ 目的の化合物のモノアイソトピック質量(0 価)が必要になります。わからない

場合は、前述の‘Calculator を用いたモノアイソトピック質量(精密質量)と平

均分子量の計算方法’の項を参考に組成式から事前に計算してください。 

 ナビゲーションバーの Compound Optimization をダブルクリックします。 

 Instrument Optimization 画面で Inlet に Infusion を選択します。 

 Mass Spectrometer の MS/MS Analysis を選択します。 

 
 

 

 

 

 Next で次の画面に進みます。 

 Precursor Ion の欄は、MW Ion を選択し、±0.7 を入力します。 

 Polarity の欄は、Positive を選択

します。 

※ Negative モードでイオン化

が 確 認 さ れ た 場 合 は 、

Negative を選択します 

※ Positive、Negative の両方で

イオン化が確認された場合

は、Both を選択します。 

 Product Ion の欄は、Auto Select
を選択します。 

 Auto select の右側 Criteria をク

リックします。 
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 下記を参考に各数値を入力します。 
(Training では右のように入力し

てください。) 

￭ For the Most Intense： 

4～6 を入力します。検出さ

れたプロダクトイオンのう

ち、強度の高い方から順に

何番目までを候補とするか

を設定します。 

￭ Build final method using： 

4～6 を入力します。一段目で候補となったプロダクトイオンのうち、強度の

高いほうから順に何番目までをメソッドに登録するかを設定します。ここに

入力できる値は一段目の数値以下の値となります。 

￭ Exclude Product Ions within： 

5 を入力します。プリカーサーイオンから最低何マス減ったものを候補とする

かを設定します。脱水されただけのプロダクトイオンを使用しないようにす

るには 20 程度を入力します。 

￭ Min for Product Ion： 

50 を入力します。候補とするプロダクトイオンの最小値です。小さいプロダ

クトイオンは測定に不利になる場合があるので、50 が推奨されますが必要に

応じて下げてください。 

￭ Threshold for Product Ion： 
プロダクトイオンの強度の閾値です。0 のままでご使用ください。 

 OK をクリックし、元の画面に戻ります。 

 Next で次の画面に進みます。 

 Target Compound 画面で、測定対象の名称 (Compound Name) と分子量（MW、 
モノアイソトピック質量）、価数 (No. Charges) を入力します。 

※ 入力する化合物数は、5 化

合物程度までが適当です。 

※ 分子量(MW)には、モノア

イソトピック質量(0 価、

+1 でも-1 でもない値)を
入力します。モノアイソト

ピック質量は平均分子量

とは異なります。 

※ モノアイソトピック質量は、Analyst の Calculators 機能を使用すると簡単に

計算できます。前述を参考に計算してください。 

 Finish をクリックすると最適化が始まります。 
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※ 複数化合物を同時に最適化している場合、基準に入らなかったものだけを外

して、再度行うこともできます 

※ 最適化中、画面に最適化中のログとデータが表示されます。 

※ 測定対象が濃すぎる、または薄すぎると、画面に警告が出て最適化が停止し

ます。この場合、溶液を希釈、または濃いものを再調製し、再度最適化を行っ

てください。 

 終了後、“Compound Optimization Completely Successful”の画面が表示されます

ので、OK をクリックして最適化を終了します。 

※ 最適化が終了すると、測定物質名_Qopt_FinalMRM_Pos.dam という名称の

ファイルが自動作成されます。 

※ Training では Reserpine_ FinalMRM_Pos.dam が作成されます。 

※ 自動最適化中にできたメソッドは、Acquisition Method フォルダに、Data は

Data フォルダに、ログは Log フォルダに保存されます。 

※ 自動作成されたこれらのファイルを Analyst®ソフトウェアから確認するには、

以下の方法で File type を変更して開いてください。 

￭ Acquisition Method File の場合： 

Open File→Files of type から Acquisition Method (*.dam) を選択しま

す。 

￭ Data File の場合： 

Open File→Files of type から Wiff Files (*.wiff) を選択します。 

￭ Log File の場合： 

Open File→Files of type から Report Files (*.rtf) を選択します。 
 

 開いている画面をすべて閉じます。 

 Manual Tuning をダブルクリックして Manual Tune 画面を起動し、Stop Syringe
をクリックして、シリンジポンプを停止します。 
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イオンソースの最適化を行う（FIA の最適化） 

※ 必須ではありません。イオン源パラメータ初期値で測定し、期待の感度に達

していない場合などに行います。 

【FIA の準備】  

 LC 移動相を準備します。 

※ 実際の測定時に使用する LC 溶媒を推奨します。 

 標準溶液を準備します。 

※ 標準溶液濃度の目安は下記をご参照ください。 

機種 濃度 

API 2000TM 、QTRAP® 100ng/mL 

API 3000TM 、API 3200TM、3200 QTRAP®、API 4000TM 
4000 QTRAP®、Triple Quad™4500、QTRAP® 4500 

10ng/mL 

API 5000TM、Triple Quad™ 5500、QTRAP® 5500、 
Triple Quad™ 6500、QTRAP® 6500 

1ng/mL 

   【ヒント】 

※ Infusion 時の 1/10～1/1 濃度の標準液を使用します。 

※ Training に使用する LC 移動相と標準液 Reserpine については、講義資料の

その他の Tips の項を参照ください。 

 LC と MS を接続します。 

 カラムオーブンから出ているピーク

チューブは、直接イオンソースに接続し

て下さい。 

 前述の“スプレー位置の調整”の LC/MS
の測定時の項を参考にスプレー位置を調

整します。 

【機器設定の変更】 

 Analyst®ソフトウェアの右下のアイコ

ンが緑になっている場合は、Queue Manager が表示されている状態で、メニュー

から Acquire>Standby を選択し、アイコンを黄色にします。（黄色の場合は②に進

みます。） 

 Configuration を切り替えるため、Hardware Configuration をダブルクリックしま

す。 

 開いた画面で MassSpecOnly を選択して、Deactivate Profile をクリックします。 

 LCのポンプ及びオートサンプラーを制御するProfileを選択し (Mass + LCなど)、
Activate Profile をクリックします。 
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※ Mass + LC 以外の名前がついている場合は ekspert 100-XL など、お使いの

LC システムが接続されている profile を選択します。 

 上記⑨で選択した Profile に緑色のチェックが点灯したことを確認後、 Close をク

リックして、Hardware configuration を閉じます。 

【FIA 用のメソッドの作成】 

 File メニュー>Open で file type として Acquisition Method を選択します。 

 インフュージョンで最適化したメソッド 測定物質名_Qopt_FinalMRM_ 

Pos.dam を選択します。 

 Training では Reserpine_Qopt_FinalMRM_Pos.dam という名称のファイルを選択

します. 

 Acquisition Method 上を

右クリックし、

Add/Remove Device 
Method を選択します。 

 ご使用の LC システム、またはデバイス全てにチェックを入れ、OK をクリックし

ます。 

◯Eksigent100/110 シリーズの場合  ◯ExionLC の場合 

 

 

 

◯島津製作所の場合        ◯Agilent の場合 

◯Waters の場合  

 
 
 
 

 バルコバルブが含まれている場合、Integrated 
Valco Valve の Use のチェックを外し、Valco 
Valve が含まれない状態にします。 

 

 

 
バルコバルブが

含まれない状態 

バルコバルブが

含まれる状態 
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 Acquisition Method をクリックします。 

 Synchronize Mode を LC sync にします。 

※ LC sync へ変更することにより、オートサンプラーの注入開始と同時に MS
の測定が開始されます 

 Mass Spec をクリックします。 

 Duration（測定時間、min）に 1min、Time に適当な値（以下のヒント参考、Training
では 1000msec）と入力します。 

【ヒント】 

※ Time とは Dwell Time を指します。FIA にて多成分一斉分析を行う場合は、

全ての成分を足すと 1000msec 程度になるように入力します。 

※ 5成分同時分析の場合、200msecずつになります。詳しくは後述の【Cycle Time, 
Dwell Time, Pause Time】を参照ください。 

 Edit Parameter をクリックします。 

 開いた画面で Source/Gas をクリックし、次ページ

以降の表に記載されている FIA 用のイオンソース

の初期値を入力します。 
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＜イオン源パラメータ初期値＞ 
API 2000TMおよび QTRAP® 

 設定範囲 TurboIonSpray®Source 
(5uL/min, Infusion) 

TurboIonSpray®Source 
(200uL/min, FIA) 

Heated Nebulizer 
(1000uL/min) 

CUR 10～55 25 40 45 
CAD 0～12 4 4 4 

IS 0～5500 5500(-4500) 5500(-4500) N/A 
NC 0～5500 N/A N/A 2(-2) 

TEM 0～550 0 300 300 
Gas1 0～90 25 50 60 
Gas2 0～90 0 80 15 

Interface 
Heater 

1[on], 0[off] 1[on] 1[on] 1[on] 

※カッコ（）内は Negative モード時の設定値を表します。 
※Negative の IS の下限は-4500 です。 
※TIS の設定温度（TEM）は最大 500℃までにしてください。 

550℃でも使用できますが、ヒーターの寿命が短くなりますので推奨しません。 

API 3000TM 

 設定範囲 TurboIonSpray®Source 
(5uL/min, Infusion) 

TurboIonSpray®Source 
(200uL/min, FIA) 

Heated Nebulizer 
(1000uL/min) 

NEB 1～15 8 14 10 
CUR 6～15 8 10 10 
CAD 0～12 4 4 4 

IS 0～5500 5500(-4500) 5500(-4500) N/A 
NC 0～5 N/A N/A 2(-2) 

TEM 0～550 0 300 300 
外付け Turbo

ガス 0～ 0 6L/min 50psi 

※カッコ（）内は Negative モード時の設定値を表します。 
※Negative の IS の下限は-4500 です。 

API 3200TMおよび 3200 QTRAP®  

 設定範囲 TurboIonSpray®Source 
(5uL/min, Infusion) 

TurboIonSpray®Source 
(200uL/min, FIA) 

Heated Nebulizer 
(1000uL/min) 

CUR 10～50 20 20 20 
CAD 0～12 3 3 3 

IS 0～5500 5500(-4500) 5500(-4500) N/A 
NC 0～5 N/A N/A 2(-2) 

TEM 0～750 0 300 300 
Gas1 0～90 20 70 60 
Gas2 0～90 0 60 N/A 

Interface 
Heater 

1[on], 0[off] 1[on] 1[on] 1[on] 

※カッコ（）内は Negative モード時の設定値を表します。 
※Negative の IS の下限は-4500 です。 
※TIS の設定温度（TEM）は最大 700℃までにしてください。 

750℃でも使用できますが、ヒーターの寿命が短くなりますので推奨しません。 
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API 4000TM、4000 QTRAP®  

 設定範囲 TurboIonSpray®Source 
(5uL/min, Infusion) 

TurboIonSpray®Source 
(200uL/min, FIA) 

Heated Nebulizer 
(1000uL/min) 

CAD 0～12 4 4 4 
CUR 10～50 20 30 45 
Gas1 0～90 20 50 60 
Gas2 0～90 0 80 N/A 

IS 0～5500 5500(-4500) 5500(-4500) N/A 
NC 0～5 N/A N/A 2(-2) 

TEM 0～750 0 300 300 
Interface 
Heater 

1[on], 0[off] 1[on] 1[on] 1[on] 

※カッコ（）内は Negative モード時の設定値を表します。 
※Negative の IS の下限は-4500 です。 
※TIS の設定温度（TEM）は最大 700℃までにしてください。 

750℃でも使用できますが、ヒーターの寿命が短くなりますので推奨しません。 
API 5000TM  

 設定範囲 TurboIonSpray®Source 
(5uL/min, Infusion) 

TurboIonSpray®Source 
(200uL/min, FIA) 

Heated Nebulizer 
(1000uL/min) 

CAD 0～12 4 4 4 
CUR 10～50 20 30 45 
Gas1 0～90 20 50 60 
Gas2 0～90 0 80 N/A 

IS 0～5500 5500(-4500) 5500(-4500) N/A 
NC 0～5 N/A N/A 2(-2) 

TEM 0～750 0 300 300 
Interface 
Heater 

1[on], 0[off] 1[on] 1[on] 1[on] 

※カッコ（）内は Negative モード時の設定値を表します。 
※Negative の IS の下限は-4500 です。 
※TIS の設定温度（TEM）は最大 700℃までにしてください。 

750℃でも使用できますが、ヒーターの寿命が短くなりますので推奨しません。 
Triple Quad™4500、QTRAP® 4500、Triple Quad™5500、QTRAP® 5500 
Triple Quad™6500、QTRAP® 6500  

 設定範囲 TurboIonSpray®Source 
(5uL/min, Infusion) 

TurboIonSpray®Source 
(200uL/min, FIA) 

Heated Nebulizer 
(1000uL/min) 

CAD 0～12 9 9 9 
CUR 10～50 20 30 45 
Gas1 0～90 20 50 60 
Gas2 0～90 0 80 N/A 

IS 0～5500 5500(-4500) 5500(-4500) N/A 
NC 0～5 N/A N/A 2(-2) 

TEM 0～750 0 300 300 
Interface 
Heater 

1[on], 0[off] 1[on] 1[on] 1[on] 

※カッコ（）内は Negative モード時の設定値を表します。 
※Negative の IS の下限は-4500 です。 
※TIS の設定温度（TEM）は最大 700℃までにしてください。 
750℃でも使用できますが、ヒーターの寿命が短くなりますので推奨しません。 
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 以降の各 LC の入力方法を参考に以下の LC 条件を入力します。 

 

 

 

 

 

 

 

 

【Eksigent  ekspert ultraLC 100-XL の場合】 

 File メニュー ＞ Save as を選択し、適当なファイル名を入力し、Acquisition 
Method を保存します。 

※ Training では Reserpine_FIA.dam と入力します。 

 Acquisition Method を閉じます。 

 Companion Software から ekspert ultraLC 100-XL をダブルク

リックします。 

 メニューバーの File から Open をクリックし、Analyst で保存し

たメソッド「Reserpine_FIA.dam」を選択します。 

 

 Autosampler をクリックします。 Autosampler 条件を設定します。 

 

 

 

 

 

 

  

0.1%ギ酸を含む精製水、または 0.1%酢酸を含む精製水 

アセトニトリル、またはメタノール 
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 Pump をクリックします。 Pump 条件を設定します。 
 
 
 
 
 
 
 
 
 
 

 Column Oven をクリックします。Column Oven
条件を設定します。 

 File メニュー ＞ Save を選択し、上書き保存しま

す。 

 

 

 

 

【ExionLC の場合】 

 Sciex LC System をクリックします。 

※ バツマークが入っている場合はその上を右クリックし、Use を選択します。

ださい。 

 Binary Gradient タブをクリックします。 

 Stop Time に 1.0min、
Flow (流速) 、B Conc.
に適当な値を入力します。 

※ 流速、移動相組成

は、実際に使用す

る組成、流速を入

力してください。 

※ 将来、グラジェン

トで分析される場

合は、対象成分が

検出される時の溶

媒組成を入力して

下さい。 

※ A Conc.には入力できません。必ず B Conc.に入力して下さい。 

※ Training では 0.2 (mL/min) 、に 50 (%) を入力してください。 
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 Autosampler タブをクリックします。 

 Sample Rack Settings をクリックします。 

 1.5mL バイアルの場合は、Needle Stroke を 52 mm に変更します。 

96well プレートの場合は、Needle Stroke を 50 mm に変更します。 

 Rinse Settings の Rinse Mode を Before and after aspiration に、Rinse Dip Time 
(オートサンプラーのニードル Wash 時間) に 0 sec を入力します。 

 必要に応じて Rinsing Volume、Rinse Method、Cooler Temperature を入力します。 

 Injection をクリックし注入量を入力します。 

【注意】 

※ Injection Volume は 100 と入力すること

ができますが、50μL 以上入力しないでください。 

 File メニュー ＞ Save as を選択し、適当なファイル名を入力し、保存します。 
 ※Training では Reserpine_FIA.dam と入力します。 
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【島津社製 LC の場合】 

 Shimadzu LC System をクリックします。 

※ バツマークが入っている場合はその上を右クリックし、Use を選択します 

 Pumps タブをクリックします。 

 Pumping ModeからBinary 
Flow を選択します。 

 Pressure Limits の

Maximum に適切な値を入

力します。 

 Flow (流速) 、B Conc.に適

当な値を入力します。 

※ 流速、移動相組成は、

実際に使用する組成、

流速を入力してくだ

さい。 

※ 将来、グラジェントで分析される場合は、対象成分が検出される時の溶媒組

成を入力して下さい。 

※ Training では 0.2 (mL/min) 、に 50 (%) を入力してください。 

 Autosampler タブをクリックします。 

 1.5mL バイアルの場合は、Needle Stroke を 52 mm に変更します。 

96well プレートの場合は、Needle Stroke を 50 mm に変更します。 

 Rinse Dip Time (オートサンプラーのニードル Wash 時間) に 0 sec を入力します。 

 必要に応じて Rinsing Volume、Rinse Method、Cooler Temperature を入力します。 

 Rinse Mode を Before and after aspiration にします。 

120 
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 Time Program タ ブ を ク

リックし、右図を参考に FIA
用の LC 条件を入力します。 

※ 1 行目の Parameter に

は⑤で設定した初期の

B 濃度 (%) を入力し

てください。 

【注意】 

※ グラジェントの最後に

は必ず Controller Stop 
を入力して下さい。 

 

 Injection をクリックし注入量を入力します。 

【注意】 

※ UFLC XR をご使用の場合、Injection Volume は 100 と入力することができ

ますが、50μL 以上入力しないでください。 

 File メニュー ＞ Save as を選択し、適当なファイル名を入力し、保存します。 

※ Training では Reserpine_FIA.dam と入力します。 

 

【Agilent 社製 LC の場合】 

 LC Binary Pump をクリックします。 

※ バツマークが入っている場合は、その上を右クリックし、Use を選択してく

ださい。 

 画面の右に Pump のタイムプログラムを入力するテーブルが表示されます。

 0 分に LC 初期条件（流速、組成）を入力し、LC の終了時間（0.5 分）にも同様

に入力します。 

※ 流速、移動相組成は、実際に使用する組成、流速を入力してください。 

※ 将来、グラジェントで分析される場合は、対象成分が検出される時の溶媒組

成を入力して下さい。 

※ Training では 0.2 (mL/min) 、に 50 (%) を入力してください。 
 

 

 

 

 

0.50 
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 Auto sampler をクリックします。  

 画面の右にオートサンプラーの設定(注入量、ニードルウォッシュの設定、冷却温度

の設定など)が表示されますので、値を設定します。 

 

 

 

 

 

 

 

 File メニュー ＞ Save as を選択し、適当なファイル名を入力し、保存します。 
※Training では Reserpine_FIA.dam と入力します。 
 
 

【Waters 社製 LC の場合】 

 File メニュー ＞ Save as を選択し、適当なファイル名を入力

し、Acquisition Method を保存します。 

※ Training では Reserpine_FIA.dam と入力します。 

 Acquisition Method を閉じます。 

 Companion Software から ACQUITY Method Editor を 

ダブルクリックします。 

 メニューバーの File から Open method をクリックし、Analyst で保存した 
メソッド「Reserpine_FIA.dam」を選択します。 
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 ACQ-BSM をクリックします。 Pump 条件を設定します。 

 ACQ-SM をクリックします。 Autosampler と Column Oven 条件を設定します。 

※ 注入量は別画面で設定します。 

 File メニュー ＞ Save method を選択し、上書き保存します。 

 

FIA 用に作成したメソッドで機器を平衡化する 

 LC のラインが MS に接続されていることを確認します。 

 標準溶液の入ったバイアルをオートサンプラーに置きます。 

 ツールバーの をクリックし、Queue Manager の画面を開きます。 

 ツールバーの をクリック、または Acquire メニューの Acquire >Equilibrate
を選択し、装置を平衡化します。 

【注意】 

※ Queue Manager が開いている状態でないと、Equilibrate は行えません。 

 開いた画面で、作成した FIA 用のメ

ソッドを選択し、OK をクリックし

ます 

※ Training では

Reserpine_FIA.damを選択し

ます。 

※ この平衡化で、イオンソース

の温度や LC が作動し始めま

す。 

※ イオンソース全体が温度平衡

になるのに 10 分程度かかりますので、その後 FIA による最適化を始めます。 
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FIA によるイオンソースの自動最適化を始める 

 Tune and Calibrate Mode の

Compound Optimization をダブル

クリックします。 

 開いた画面で FIA をチェックし、

FIA 用のメソッドをプルダウンメ

ニューから選択します。 

※ Training では

Reserpine_FIA を選択します。 

 Rack Code、Rack Position、Plate Code、Plate Position、Injection Volume に間

違いがないことを確認します。 

 Acquisition Method 作成時に注入量を指定しない LC の場合は、この画面で注入量

を入力します。 

 Next をクリックし、次の画面に進みます。 

 メソッド中にあるチャンネルとバ

イアルポジションが表示されます。

Compound Name に測定物質名、

Vial Pos. にバイアルポジション

を入力します。 

※ Training では Compound Name には Reserpine、Vial Pos. には 1 と入力し

ます。 

【注意】 

※ 入力行ごとにバイアルポジションを変えるとそれぞれの行（チャネル）に対

して、複数回の最適化を行います。この場合、最適化が終了した後、複数の

メソッドに分かれます。 

※ Int. Std.にチェックを入れると内部標準物質扱いになり、ピークの測定はされ

ますが、最適化するにあたって考慮されません。 

 Next をクリックします。 

 次ページを参考にパラメータとして検討する値を右側に入力します。 

1) 検討する値を 10;20;30 のようにセミコロンで区切って入力します。 

2) 最適化するパラメータは Optimize にチェックを入れます。 

※ パラメータが入力されていない場合は警告が出ます。値を入力してから再度

チェックを入れます。 
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＜FIA パラメータ初期値＞ 

API 2000TMおよび QTRAP® 

 

 

 

 

 

 

 

 

 
 

API 3000TM 

Nebulizer Gas 12;13;14;15;16 

Curtain Gas 8;9;10;11;12 

IonSpray Vol. 4500;5000;5500 ★ 

Temperature 300;400;500 

Collision Gas 3;4;5;6;7;8 

外付けターボガス 6～7L/min 

 

API 3200TMおよび 3200 QTRAP®  

Curtain Gas 10;15;20;25;30;35;40  

IonSpray Vol. 4500;5000;5500 ★  

Temperature 300;400;500;600;700  

Gas1 30;40;50;60;70;80  

Gas2 30;40;50;60;70;80  

Collision Gas 3;4;5;6;7;8  

 

 

 

バージョンによっては、0ul と表示されますが、 

分析は正常に行われます。 

750℃にするとヒーターが 

切れやすい 

1) 検 討 す る 値 を

10;20;30のようにセミ

コロンで区切って入力

します。 

2) 最 適 化 す る パ ラ メ ー タ の

Optimize にチェックを入れます。 

550℃にするとヒーターが切れやすい 

※ API 3000TM LC/MS/MS 
System では Interface Heater 及
び Ion Source Gas2 はありませ

ん。 

※ ネブライザーガス（NEB）が

Ion Source Gas1 に相当します。 

★ 移動相が高流速の場合は

2000; 2500; 3000;3500;4000 あわ

せて検討ください。 

★ 移動相が高流速の場合は

2000; 2500; 3000;3500;4000 あわ

せて検討ください。 
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API 4000TM、4000 QTRAP® 

Curtain Gas 10;20;30;40  

IonSpray Vol. 4500;5000;5500 ★  

Temperature 300;400;500;600;700  

Gas1 30;40;50;60;70;80  

Gas2 30;40;50;60;70;80  

Collision Gas 3;4;5;6;7;8  

API 5000TM 

Curtain Gas 10;20;30;40   

IonSpray Vol. 4500;5000;5500 ★   

Temperature 300;400;500;600;700   

Gas1 30;40;50;60;70;80 
 

 

Gas2 30;40;50;60;70;80   

Collision Gas 3;4;5;6;7;8   

Triple Quad™ 4500、QTRAP® 4500 

Triple Quad™ 5500、QTRAP® 5500 

Triple Quad™ 6500、QTRAP® 6500  

Curtain Gas 10;20;30;40   

IonSpray Vol. 4500;5000;5500 ★ 
 

 

Temperature 300;400;500;600;700   

Gas1 30;40;50;60;70;80 
 

 

Gas2 30;40;50;60;70;80   

Collision Gas 6;7;8;9;10;11;12   

 

【注意】 

※ Negative モードでの FIA では、IS は－4500 までしか入力できません。 

※ Negative の IS の下限は-4500 です。Positive の IS 値のまま Negative で 

※ 最適化を行うとエラーが発生します。Positive⇒Negative、または Negative
⇒Positive に変更して最適化を行う場合は、IS 値を入力し直してください。 

 

30 以下にするとオリフィスが 

汚れやすい 

750℃にするとヒーターが 

切れやすい 

750℃にするとヒーターが 

切れやすい 

★ 移動相が高流速の場合は

2000; 2500; 3000;3500;4000 あわ

せて検討ください。 

★ 移動相が高流速の場合は

2000; 2500; 3000;3500;4000 あわ

せて検討ください。 

★ 移動相が高流速の場合は

2000; 2500; 3000;3500;4000 あわ

せて検討ください。 

750℃にするとヒーターが 

切れやすい 
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 画面下部に Replicate Injection for each parameter（一つの条件につき何回測定す

るか）にチェックを入れます。 

※ Training では 1 にチェックを入れます。 

【注意】 

※ 画面下部に必要な容量が計算されますので、バイアルに充分量入っているこ

とを確認してください。 

 Next をクリックし、次ぐの画面に進みます。 

 次の画面は何も入力せず、Finish をクリックし、最適化を始めます。 

※ この画面は、DP などのインフュージョンで最適化するパラメータについて値

を振って測定をする画面です。通常インフュージョンで最適化が終了してい

ますので、入力、最適化の必要はありません。 

 終了後、“Compound Optimization Completely Successful”の画面が表示されます

ので、OK をクリックして最適化を終了します。 

※ 最適化が終了すると、(最初のメソッド名)_FIASample1.dam という名称の

ファイルが自動作成されます。 

※ Training では Reserpine_FIA_FIASample1.dam となります。 

 開いている画面をすべて閉じます。 

 

 

3.4 測定メソッド(Acquisition Method)の完成 

※ ここでは、2.で最適化した条件に LC 条件を入力し、測定メソッドとして完成

させます。 

 Navigation Bar 上で Acquire をクリックし、Acquire モードにします。 

 メニューの File>Open から画面を開き、File type を Acquisition Method とし、FIA
により最適化されたメソッドを開きます。 

※ Training では Reserpine_FIA_FIASample1.dam を選択してください。 

 以降の各 LC の入力方法を参考に LC 条件を入力します。 

※ Training では以下の条件を使用します。 

o 流速：0.2ｍL/min 

o Gradient 条件：右図 

o Injection Volume: 5µL 
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【Shimadzu UFLC の場合】 

i. LC ポンプの設定を行います。Pumps タブをクリックし、Pumping Mode は

Binary Gradient を選択し、Total Flow、Pump B に初期条件を入力します。 

ii. Autosampler タブをクリックします。 

iii. Rinse Dip Time (オートサンプラーのニードル Wash 時間)に 0 sec を入力します。 

iv. Rinse Dip Time は、0 sec に設定しても動作します。0 sec の場合、液につけてす

ぐに引き上げます。 

v. サンプル温度（Cooler Temperture）を設定します。 

vi. Rinse Mode を Before and after aspiration にします。2 液洗浄の場合は、Rinse 
Method を Rinse Pump Then Port にします。 

￭ Before and after aspiration：注入前後にニードル洗浄します。 

￭ Rinse Pump Then Port：2 液⇒1 液という順で洗浄します。 

vii. Oven を選択し、条件を設定します。 
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viii. Time Program タブをクリック

し、適当な LC 条件を入力します。 

※ グラジェントの最後には必

ずController Stop を入力し

て下さい。 

 

 

 

ix. Injection をクリックし注入量を

設定します。 

 

 

 【Agilent 社製の設定】 

i. LC Binary Pump を

クリックします。LC 
Pump Gradient タブ

に、LC 条件を入力し

ます。0 の行には、LC
初期条件（流速、組成）

を入力します。 

※ 0 の 行 の Total 
Time に 0 以外の

数値を入力すると、

平衡化されます。 

ii. Auto sampler をクリックします。 

iii. Injection Volume の

欄 に 注 入 量 、

Temperture Control
の Setpoint に、サン

プル温度を設定しま

す。 

iv. Wash Location で、洗

浄方法を設定します。“Wash Vial”の場合は、Wash Vial Number に洗浄用のバ

イアル番号を入力します 

v. Column Oven をク

リックし、設定温度

を入力します。 
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 Mass spectrometer をクリックし、Duration に測定時間を設定します。通常、LC
の測定時間に合わせます。 

 

 

 

 

 

 

 

 

 

 以下を参考に、Time に Dwell Time を入力し、Cycle Time が十分短いことを確認

します。 

※ Dwell Time は、クロマトグラムにおけるピークの溶出幅とデータポイント数

から換算して設定します。 

 

  【Cycle Time, Dwell Time, Pause Time】 

￭ 例えば、定量する化合物（Analyte）の溶出幅が 0.1 min (6 sec)と仮定した場

合、データポイント数が 10 ポイント（10 Cycle）のデータを取得するには、

1 Cycle Time を 0.6 sec 以下に設定する必要があります。 

￭ Cycle Time は Dwell Time と Pause Time (通常 5msec) の合計であることか

ら、Dwell Time は 595 msec と設定することになります。 

 

 

 

 

 

  

④ 

⑤ 
⑤ 
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 必要に応じてValco Valveの設定を行います。下記は0-2分をAポジション（Waste）、
2-10 分は B ポジション（MS online）の設定です。 

※ Training では使用しません。 

 

 

 

 

 

 

 

 

 

通常の設定の場合、 

10 方バルブ（3200）は 

Position A：10-1, 2-3, 4-5, 6-7, 8-9 

Position B：1-2, 3-4, 5-6, 7-8, 9-10 

6 方バルブ (4500, 5500) は 

  Position A：6-1, 2-3, 4-5 

  Position B：1-2, 3-4, 5-6 

がつながっています。 

特殊な設定になっている場合もありますので、 

どの番号のポートから液が出るかをご確認の上、ご使用ください。 

 

【注意】 

※ Valve の切り替え時間は、MS の測定開始時間（0min）、終了時間（上のメ

ソッドでは 12min）には設定しないでください。0－12 分の分析の場合、

0.5-11.5 分の間で切り替え時間を設定します。 

※ Valve を使用しない場合は、Integrated Valco Valve 上を右クリックして Use 
のチェックを外します。 

 

 上書きする場合は、そのまま Save し、名称を変える場合は、File>Save as を選択

し適当な名前で保存します。 

※ Training では Reserpine_Grad.dam と入力します。 
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3.5 測定 

カラムの接続 

 カラムを接続します。（Training では接続しません。） 

System の平衡化 

￭ 以下の方法で LC および MS を、測定に使用するメソッドの初期条件で動作

します。この操作で、System を安定させます。 

 Acquire モードをクリックし、Acquire にします。  の場合はクリックし、      

に変更します。（既になっている場合は必要ありません。） 

 メニューの View>Sample Queue から Queue Manager を選択、あるいは、Acquire 

モードでツールバーの アイコンをクリックし、Queue Manager を開きます。 

 

 

 

 メニューの

Acquire>Equilibrate を選択、

あるいは、ツールバーの ア

イコンをクリックします。 

 作成した Acquisition Method 
を選択、Time に、平衡化時間

を入力し、OK をクリックしま

す。 

 設定した時間後、右下の

Status bar の MS アイコンが、緑色の Ready の状態になるのを確認します。 

 

Batch の作成 

￭ 以下の方法で測定するサンプルの情報（サンプル名、バイアル番号等）を入

力します。Submit することで Queue Manager に登録します。（この操作で

測定待ちの状態になります。）。 

 Build Acquisition Batch をダブルクリックします。デフォルトの Batch が開きます。 

 Acquisition に測定に使用するメソッドを選択します。 

※ Training では Reserpine.dam を選択します。 

※ Method Editor ボタンで選択されたメソッドの編集・確認が出来ます。 
 

 

 

 

③ 

②  
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 必要に応じ、Quantitation
で none が選択されている

状態で Quick Quant をク

リックします。 

※ この操作で濃度や

IS(=Internal 
Standard)の設定が

できるようになり、

解析時に入力の必要

がなくなります。 

※ 行わない場合は、⑧にスキップください。 

 Q1/Q3 の欄をクリックすると、測定メソッドに設定されているチャンネルが表示さ

れます。該当するチャンネルを選択し、Name に成分名を入力します。多成分一斉

分析の場合には、全てのチャンネルを Q1/Q3 で表示させ、それらの成分名を全て入

力します。 

※ Training では Reserpine1 成分のみとなります。 

 定量解析を Analyst Software で行う場合、必要に応じて Default Smooth Width に

てクロマトグラムにかけるスムージングの係数を設定します。 

※ 定量解析を MultiQuant Software で行う場合、設定の必要はありません。 

 内部標準を用いた定量を行う場合には、Internal Standard欄に内部標準物質のチャ

ンネルと成分名を入力し、Analytes 欄の Internal Standard にて該当する内部標準

物質を選択します。複数の内部標準物質を設定することも可能です。 

 全てを入力し OK をクリックすると、解析用メソッドの名称を入力する画面が表示

されます。入力し、OK をクリックします。 

※ Training では Reserpine と入力します。 

※ 解析用メソッド (Quantitation Method ： *.qmf) は、測定用メソッド

（Acquisition Method：*.dam ）とは拡張子が異なりますので、同じ名称で

も構いません。 

 Add Set をクリックし、Add Samples をク

リックします。画面が開きます。 

 測定する回数分の数字を Number Box に

入力します。 

 OK をクリックするとその本数分だけ

Batch に列が追加されます。 

※ Training では 6 を入力します。 

  

⑤ ⑥ 

④ ⑥ 
④ 
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 Sample Name にサンプルの名称を入力します。 

 Rack Code でオートサンプラーのトレイを選択します。 

 Vial Position にバイアルの番号を入力します。（Location Tab で確認、選択可能で

す。） 

 Data File 名を記入します。 

※ Data File 名が同一の場合、複数のデータが一つのファイル(.wiff ファイル)に
保存されます。Sample 名が同一でも、上書きされることはありません。 

 

 

 

 

※ 数値や文字を繰り返して入力する

場合には、繰り返したい範囲をド

ラッグして選択、右クリックにて 

Fill Down を選択します。 

※ 同様に AutoIncrement を選択する

と、自動的にカウントアップされ

た数字が入力されます。 

 

 

 Quantitation タブをクリックして、サンプル

の情報を入力します。Quant TypeにてBlank、
Standard 及び Unknown の選択を行い、成

分名（Training では Reserpine と表示されて

います）の下に Standard の濃度を入力します。 

 必要に応じて、Batch を保存します。保存は File メニューから Save As…を選択

し名称を入力します。 
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 Submit タブをクリックし、Submit 画面に移行します。この画面では、情報の入力

は行わず、どのサンプルを測定するかの決定を行います。 

※ すべてのサンプルを測定する場合は、そのまま右上の Submit をクリックしま

す。 

※ 一部を測定する場合は、選択し反転させた後、Submit をクリックします。 

 選んだ部分を測定するか、全てを測定するかを選択し、OK をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

※ すでに Submit したことのあ

るサンプルを再度 Submit し

た場合には、警告があらわれ

ます。問題なければ Yes をク

リックします。 

※ この操作により測定するサン

プルと順序が決定されますが、そのままでは測定は始まりません。 

 

 ツールバーの  (Queue Manager アイコン)をクリックし Queue Manager の画面

を開きます。 

 

 

 

 

 

 

※ 誤って Submit した場合は、Queue Manager 上を右クリック、ポップアップ

メニューから Delete＞Delete Batch で取消すことができます。 
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測定の開始 

 

 メニューの Acquire>Start Sample を選択し、測定を開始します。 

※ 測定の途中で停止する場合は、Acquire>Abort Sample を、 

※ 測定時間を延ばす場合は、Acquire>Extend Period を選択します。 
 

※ Tuning モードが選択されている場合、Start Sample アイコンをクリックして

も、下記のエラーメッセージが出てサンプルが Run できません。この場合、         

アイコンを 1 回クリックし、  に変更してください 

※ オートサンプラーがインジェクションをする前に(Mass が Run する前に)、
Abort Sample を選択しないでください。ツールバーのアイコンを操作できな

くなることがあります。 

 

※ 測定中の Data を Explore Mode で確認することができます。方法については

以降の“データの確認”を行うの項を参照ください。 
 

※ Queue Manager の最後のサンプルを測定後、設定時間が経過すると、LC は

自動で止まり、MS は Standby の状態 idle（黄色いアイコン）に戻ります。 
 

 

 

 

 

Start Sample Abort Sample Extend Period 
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4 停止操作 

 メニューバーの Acquire から Standby をクリック、あるいは Standby アイコンを

クリックします。 

     ＜メニューバーからの方法＞     ＜アイコンからの方法＞ 

 

 

 

 

 

 

 

 

 ナビゲーションバーの Hardware Configuration をダブルクリックします。 

 使用していた Profile を選択します。 

 Deactivate をクリックします。 

 Close をクリックします。 

 HPLC の電源を切ります。 

 必要に応じて PC の電源を切ります。 
  

Standby アイコン 
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5 データの確認 

データを開く 

 Project を、目的の Data の保存されている Project（Training では Example）に変

更します。 

 Explore モードを選択し、Open Data File をダブルクリックします。 

※ Training では、Triple Quad フォルダ中の QuanData.wiff 中の API3-012 の

データを使用します。 

 目的のデータの Wiff ファイル＞目的の Sample を選択し、OK をクリックします。 

 該当のデータファイルが開きます。 

 

 

 

 

 

 

 

 

 

 

 

 

【Tips】測定中の Sample 名称を選択すると、測定中のクロマトグラムを   
    リアルタイムに確認することが出来ます。 

  

前後のクロマトグラムを表示する 

 上記の順序で該当のデータを開きます。 

 前後のクロマトグラムに移る場合は、メニューバー三段目のアイコン     を

クリックします。 

￭ 左矢印  ：一つ前のクロマトグラムが表示されます。 

￭ 右矢印  ：次のクロマトグラムが表示されます。 

￭ 曲がった矢印  ：データを選択する画面が開き、任意のクロマトグラムを

表示させることができます。 

 

 

 

① 

③ ② 
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クロマトグラムの抽出 
複数のトランジションで測定している場合、個々のクロマトグラムを抜き出すことが 

できます。 

※ Training では Example の Project 内に保存されている Triple Quad フォルダ

中の QuanData.wiff 中の API3-015 のデータを使用します。 

 Explore モードを選択し、Open Data File をダブルクリックします。 

 Triple Quad フォルダ中の QuanData.wiff 中
の API3-015 をクリックします。 

 OK をクリックします。 

 

 

 

 

 

 

 

 開いたクロマトグラムを一度クリックします。 

 さらに右クリックし表示された画面上の Extract Ions をクリックします。 
【Tips】この操作は、Extract Using Dialog アイコン  をクリックしても操作    

    できます。 

 

 

 

 

 

 

 

 

 

 

 

 

  

② 

③ 

④クロマトグラム上

で右クリックします。 
⑤ 
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⑦ 

⑥ 

 クリック後、Extract ions 画面が表示され

ますので、目的のチャンネル（Training
では 400.0/200 および 420.0/220.0）をド

ラッグして選択します。 

※ 複数のチャンネルを選択する場合、

ドラッグまたはコントロールキー 

（[Ctrl]）を押しながら該当する成分

を選択してください。 

 OK をクリックします。 

 

 

 

 

 重ね書きされたクロマトグラムの下に、それぞれ抽出したクロマトグラムが表示さ

れます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

  

MRM：400/200のXIC 

MRM：420/220のXIC 

【Tips】Q1 スキャンなどのスキャンデータを選択した場合には、Extract Ions 画面で 
    抽出する値を直接入力します。 
  例：start:500, stop:500.5 など 
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クロマトグラムを拡大する 

 ExploreモードからOpen Data Fileをダブルクリックし表示したいデータを開きま

す。 

 拡大したい範囲の軸上（枠の外側）をそれぞれドラックすることで、ドラックした

箇所が拡大されます。 

※ 全拡大を解除する場合には、Home Graph アイコン   を選択あるいは、  

各軸上をダブルクリックします。 

 
 
 
 
 
 
 
 
 
 
 

分析時の測定条件を確認する 

 ExploreモードからOpen Data Fileをダブルクリックし表示したいデータを開きま

す。 

 Show File Info アイコン  をクリックします。 

 分析条件など、データを取得した際の情報が表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

開いた画面上、右クリックし、

Save Acquisition Method で、

測定時のメソッドを復元保存で

きます。 

拡大したい箇所をそれぞれドラックします。 
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【Tips】印刷する場合は、Print Pane（詳細は画面の印刷項目を参照）により   

    すべての情報が印刷されます。 

【Tips】情報が表示されないときは、Tools メニュー＞Settings から Appearance 

Options の File Information Options タブを選択し、すべてのボックスに

チェックを入れます。 

 

画面を印刷する 

 File メニュー＞Print ＞ Window、 Pane、 
Workspace のいずれかを選択します。 

￭ Window： 
1 データに表示している全画面のこと。 

￭ Pane： 
1 データに表示している各画面のこと。 

選択されている Pane は青線で囲まれます。 

￭ Workspace： 
Exploreモードで開いている全データのこと。 

 

 それぞれのプルダウンから Printer、
Report Template を選択し、部数を入力

して OK をクリックします。 

 

 

 

 

 

 

 

表示したクロマトグラムを閉じる 

  画面上を右クリックし、Delete Pane をクリックし画面を閉じるか、もしくはメ

ニューバーの Delete Pane アイコン  をクリックします。 
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6 SCIEX OS Software を用いた定量解析 

※ 本マニュアルでは SCIEX OS Software の Analytics モードを用いて解析を行

う方法を示します。Analyst® Software を使用する場合は Analyst® Software
用の Manual を、MultiQuantTM Software を使用する場合は MultiQuantTM 
Software 用の Manual を参照ください。 

￭ 濃度既知の標準液から作成した検量線をもとに、濃度未知のサンプルの定量

を行います。 

￭ 内部標準物質(IS)を使用した場合は、解析時に指定した内部標準物質によって

自動補正されます。 

￭ Training では Project: SCIEX OS_Quad Data_Example 内の curve_sulfa の

Data を使用し、以下を行います。 

o Sulfadiazine (SDZ), Sulfamerazine (SMZ)の検量線の作成 
 （内部標準物質 Sulfadimethoxine (SDMX)による補正） 

o 未知試料中の SDZ と SMZ の定量 

 

 

＜参考＞ 検量線について  

検量線（標準濃度曲線）とは、既知の

濃度の標準試料と未知の試料とを比較

することにより、未知の試料に含まれ

る物質の濃度を求める手法です。検量

線は、検体（測定対象物質）の濃度の

変化に応じて検出器がどのように反応

するかを示したグラフ（分析シグナル）

です。検量線を作成するために、未知

の検体の想定濃度を中心とする各種濃度で調整された標準物質を準備する必要があり

ます。 

 

＜参考＞ 内部標準物質について  

内部標準物質は、測定時の注入量、MS のイオン化時のサプレッションなどの効果を補

正するために使用します。生体試料など、複雑なマトリックス中で定量解析を正確に

行う必要がある場合に特に推奨されます。 

  

濃度

面
積

値
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＜SCIEX OS Software Analytics モード定量画面＞ 

  

＜よく使用するアイコン＞ 

  

Displays the Peak Review 

クリックするとクロマトグラムが表

示されます。 

Displays the Calibration Curve 

ク リ ッ ク す る と 検 量 線 が 

表示されます。 

 

クロマトグラム 

定量結果 

化合物リスト 

※ 化合物リスト

をクリックすると、

定量結果やクロマ

トグラムが表示さ

れます。 

検量線 
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6.1 SCIEX OS Software の Analytics の起動 

 デスクトップ上の SCIEX OS Software アイコン     をダブルクリックし、

起動します。 

 

 ホーム画面に表示されている Analytics のアイコン     をクリックします。 

 

6.2 Project の作成 

 上部フォルダのアイコンをクリックし、右側に Status Bar を出します。 

 Projects 右の＋をクリックします。 

 開いた画面で、Project name 欄に該当する Project 名を入力します。 

 OK をクリックすることで Project が作成されます。 

 

 

 

 

 

 

 

 

 

 

6.3 Project の選択 

 画面上部の Projects ＞ 目的の Data の格納されている Project を選択します。 

￭ Training では SCIEX OS_Quad Data_Example を選択してください。 

 

 

 

 

6.4 初期設定の変更 

 Projects をクリックし、Project Default Settings を選びます。 

 Quantitative Processing では、図を参考に、定量解析に使用するアルゴリズム

や積分条件、検量線の条件等を設定します。 

①

② ③ 

④ 
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 Qualitative Processing では、下図を参考に定性解析に使用するライブラリー

サーチや各種パラメーター等を設定します。 

※ 各種設定は状況に応じて変更します。 

 

 

6.5 Result Table の作成 

 画面上部の Results ＞ New をクリックします。 

 Process New Results 画面を開きます。(i)か(ii)の方法でデータを選択します。 

(i) Select batch Samples to process で、Available から解析するデータを選択して

右矢印をクリックして Selected に移動します。 

￭ Training では curve_sulfa.wiff の全 Data を移動してください。 
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￭ (ii) 開いたProcess New Results画面の上部右にあるBrowseボタンをクリックし、 

￭  目的の Data が格納されている Project を選択します。 

 

 Process New Results 画面の 2. Select a processing method で、以前に作成した

Processing Method（定量解析用 Method）がある場合は Browse…をクリック、使

用する解析メソッドを選択し、Process をクリックし”6.6 Results Table の確認、編

集”に進みます。 

Processing Method が無い場合、次の「新規に定量解析用メソッドを作成し、Results 
Table を作成する方法」に進みます。（Training では新規に作成します。） 

新規に定量解析用メソッドを作成し、Results Table を作成する 

 Process New Results 画 面 の 2. 
Select a processing method の New
をクリックします。 

 解析メソッドの編集画面が表示され

ます。 
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 Wokflow で、Quantitaion and targeted identification のチェックを外し、

Quantitaion にチェックが入っていることを確認します。代表サンプルが自動で選

択します。 

 Components をクリックします。化合物名、内部標準物質（IS）の情報を入力しま

す。 

※ Training Data では、311/156 が IS になります。 

※ IS が無い場合は、入力は不要です。 

 Integration をクリックします。代表サンプルの自動積分された結果が表示されます。 

ピークがうまく積分されていない場合は、次ページを参考に積分パラメータを変更

後、Apply をクリックし、クロマトグラムに反映します。 

※ パラメータは Results Table 作成後も変更できます。 
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 チャンネル（成分）をクリックし、全成分についても同様に積分パラメータを設定、

確認します。 

 

 Calculated Columns をクリックし、必要に応じて設定を行います。 

※ 設定方法は中級定量トレーニングマニュアルをご参照ください。 

 

 Flagging Rules をクリックし、真度、定量値の許容誤差について設定します。 

※ 基準値から外れた場合、定量結果のセルがピンクにハイライトされます。 

※ 設定しない場合はチェックをはずします。 

※ イオン比の表示は、中級定量トレーニングマニュアルをご参照ください。 

 

 Accuracy Acceptance をクリックし、真度の許容誤差を設定します。設定が終わっ

たら、Accept changes and return to Fragging Rules をクリックして戻ります。 

【スムージングおよび積分パラメータ】 

・Gaussian Smooth Width：スムージングをかける場合、値を入力します。 

・Min. Peak Height：ここで設定した高さ (Intensity, cps) を超えるピークを積分します。ベースラ

インよりも高めに設定することで、ノイズや強度の低いピークは積分されなくなります。 

・Noise Percentage：値を大きくする程、ベースラインが上がり、ピーク面積値が小さくなります。 

・Baseline Sub. Window：ベースラインとして設定する最小強度を検索する幅になります。Peak 幅

の 2-3 倍程度が Default 値になります。 

・Peak Splitting：値を大きくする程、割れたピークを一つのピークとして認識しやすくなります。 



6-8 

 

 Calculated Acceptance をクリックし、必要に応じて定量値の許容誤差について設

定します。Accept changes and return to Fragging Rules をクリックして戻ります。 

 Save をクリックし、File Name に解析 Method 名を入力して Save をクリックしま

す。 

 Process New Results 画面に戻ります。Process をクリックすることで、解析が開

始され、終了後 Result Table（解析結果）が表示されます。 
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6.6 Results Table の確認、編集 

 解析結果を確認後、画面上部の Results > Save as で適当な名前で保存します。 

 左の Components and Groups タブのリストから、任意の Analyte（Training では

251/108）を選択します。 

※ Samples タブでは、任意のサンプルを選択できます。Results Table はサンプ

ルごとに表示されます。 

 Sample Type を確認、編集します。変更する場合はプルダウンメニューから、標準

液：Standard、QCサンプル：Quality Control、ブランク：Blank、サンプル：Unknown
を選択してください。 

 Actual Concentration に標準液の濃度を確認、入力します。 

※ Training では 0.1、1、10、100 と入力してください。 

※ Excel などからのコピー（Ctrl＋C）、ペースト（Ctrl＋V）可能です。 

 全化合物について濃度を確認、入力します。 

※ 全化合物の濃度が同じ場合は入力後、カ

ラム上を右クリックし、Apply Current 
Analyte’s Actual Concentrations to All
を選択します（この操作で標準液濃度が

全化合物に反映されます）。 

 

 

 

④標準溶液の濃度 

③Sample Type の選択 

②Analyte の選択 

① 
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 サンプルの定量値が、Calculated Concentration に表示されます。 

 

6.7 クロマトグラムの表示 

 Results Table 画面右上の    をクリックしてクロマ

トグラムを表示させます。 

 クロマトグラム右上の Options > Show navigation 
control を選択すると、       がクロマトグ

ラム上部に表示されます。    をクリックすると、

前後のページが表示されます。 

 必要に応じて、表示されているクロマトグラム数（縦、

横数）について、変更します。変更する場合は、クロ

マトグラム右上の Options > Peak review display 
settings を選択します。Peak review Options 画面上

部の Number of rows、Number of columns で変更

後、OK をクリックしてください。 

 

6.8 パラメータの変更 

 必要に応じてクロマトグラム左に表示されているパ

ラメータ値を変更し、クロマトグラムのピーク認識

方法を変更します。 

※ 各パラメータの詳細については、P6-7【スムー

ジングおよび積分パラメータ】を参照ください。 

 変更後 Apply をクリックすると、選択したサンプル

ピークに変更したパラメータが反映されます。 

※ 全サンプルピークにパラメータを反映させる場合は次ページを参照ください。 

⑥ 定量値 

③ 
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全サンプルピークに変更したパラメータを反映させる 

 選択したサンプルに値を反映させた

後、クロマトグラム上を右クリックし

ます。 

 Update Processing Method for 
Component を選択します。 

 

 

6.9 手動積分 

※ 必要に応じて行いま

す。 

 クロマトグラム画面上部の     

  をクリックします。 

 ピークの左端をクリックし

ます。 

 そのままドラックしてピー

クの右端で離します。 

※ もとのパラメータに

戻す場合は Manual Integration 右横のチェックを外してください。 

 

ピークとしての認識を外す 

ブランク等、ピークとして認識したくない場合、ピーク不検出アイコンを押すことに

より、ピークを不検出にします。 
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6.10 検量線の表示、重みづけ、検量線の種類を変更   

 Results Table 画面右上の       をクリックし、検量線を表示します。 

 必要に応じて Regression をクリックし、重みづけや検量線の種類を変更します。 

￭ Regression Parameter：Area→Hight の変更 

￭ Regression Type：検量線の種類の変更 

￭ Weighting Type：重みづけの変更 

 

※ Training では上記のように変更してください。 

※ 操作詳細は Help をご参照ください。 

 必要に応じて画面上部の Results > Save as で定量結果を保存します。 
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6.11 データの追加と削除 

データの追加 

 Results Table 画面右上の More > Add Samples を選択し、Available で追加したい

サンプルを選択後、→で Selected に移動します。 

 OK をクリックすることで Results Table に追加されます。 

 
 

データの削除 

 Results Table で削除したい行を選択し、Results Table 画面右上の More > Remove 
Selected Samples を選択することで削除されます。 

※ 削除後、元に戻すことはできません。必要に応じて削除前に画面上部の

Results ＞Save as で定量結果を保存してください。 

 
  



6-14 

 

6.12 Report の作成 

 画面上部の Reporting > Crate report and save Results Table を選択します。 

 Create Report 画面が表示されますので、Template Name のプルダウンで目的に

沿ったレポートテンプレートを選択します。 

※ DefaultのTemplateはC:¥ProgramData¥SCIEX¥Analytics¥Reporterに保

存されています。 

※ その他、 https://sciex.jp/support-tools/analyst-multiquant-reporttemplate
からダウンロード可能です。 

 Report title の Browse をクリックしてファイル名の入力と保存先を選択します。 

 Create をクリックするとレポートが作成されます。 

 

 

 

 

 

 

 

 

 

 

 

 

＜レポート作成例＞ 

② 

③ 

① 

④ 
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研究用にのみ使用できます。診断目的およびその手続き上での使用は出来ません。 

 

AB Sciex is doing business as SCIEX.  

For Research Use Only. Not for use in diagnostic procedures.  

The trademarks mentioned herein are the property of AB Sciex Pte. Ltd. or their 

respective owners.  

AB SCIEX™ is being used under license. 

 

詳細な説明や知的所有権等に関しては付属のマニュアルを必ずご確認ください。 

 

© 2019 K.K. AB SCIEX. 
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